For the Student
Lesson 4: Using photographs in a motivational poster

Introduction

Motivational images, de-motivational images, and memes are popular items. During this lesson, you will learn to combine vector and bitmap images while creating a standard page size (letter/A4) motivational poster including one or more photos and text. You will be introduced to the Corel PHOTO-PAINT program and how it interacts with the CorelDRAW program.
At the end of the research and exploration phase, you should be able to answer several of the essential questions about using and editing photographs. You may also explore the history or career opportunities in photography and photographic processing and editing.
Essential Questions:

These questions will help guide your explorations during this lesson.

CorelDRAW and PHOTO-PAINT questions for this project. 

How do you find and import photographs into a CorelDRAW document?

What are some ways to adjust photographs from within CorelDRAW?

How do you access the PHOTO-PAINT program from CorelDRAW and why might it be better than editing photos directly in CorelDRAW?

What are layers in CorelDRAW and why would they be useful? How can they be customized?

How do objects in PHOTO-PAINT differ from objects in CorelDRAW?

What are some quick and easy ways to make some poor photographs look better?

What are some reasons you might want to convert a vector object to a bitmap?

Questions about using and editing photos:

What are the copyright laws that pertain to using photographs? When is it legal to use them? When is it not legal to use them?

What are some safety/security/privacy issues in using photographs?

If you take a photo, is it always OK to use it for anything you want?

How could editing a photo be construed as being deceitful?

Questions about photography:

What is the history of photography? How has photographic technology changed over the years?

What are the advantages and disadvantages of film and digital photography?

What is the difference between RAW digital photographic data and other formats?

Why is JPEG not always the best format for saving photos? What are some other options?

What are the career opportunities in photography?

What are some rules and guidelines for good digital photography?

Assignments:

Summary

1. Work through several help articles and videos and complete the worksheet.
2. View the Color_Correcting_photos video tutorial. Use the techniques you learn to correct at least three photos. A folder of photographs is included with this lesson or the students may use their own photographs or photos provided by the instructor.

3. Use the Sample Project 4 as a springboard for group discussion and research on copyright issues, legal uses, and security and privacy issues, and ethical issues when using photographs based on the Essential Questions. The teacher may break larger classes into groups and assign certain questions to each group. The groups should then report the findings back to the whole class. The teacher may also choose to lecture on these subjects.

4. Research the one or more of the following topics individually or as a group:

history of photography

career opportunities in photography and photographic processing, editing or retouching

digital photography techniques.

Be prepared to present your findings to the whole class.

5. Students use the information they have gained in Assignments 1-4 to create an original motivational poster of their choosing to be displayed in the classroom or elsewhere.
Assignment 1
Work through the following articles and fill out the corresponding worksheets:
Step 1 – CorelDRAW Layers and the Object Manager – Worksheet 4C
In Lesson 3, you looked at the Object Manager to see how it helped to organize and arrange objects. Now it is time to explore the layer properties of the Object Manager docker.

Layers are a great way to help organize complex drawings. In CorelDRAW, you can give each layer its own name and make each layer visible or invisible. You can lock certain layers so they can’t be accidentally edited while you work on another layer. You can choose to print some layers and not others.

You will need to have the Object Manager Docker open to work with layers. To make a layer active, click the layer name in the Object Manager. The active layer is the one where any new object drawn or imported will be placed. You can add new local layers by clicking the New Layer icon at the bottom left of the Object Manager. As with objects, layers at the top of the stack will be in front of layers lower in the stack.
[image: image1.emf]


There are two main types of layers in CorelDRAW, Local layers and Global or Master layers. CorelDRAW X6 adds options for separate odd and even Master layers.
Objects on Local layers appear only on one particular page. So a picture you draw on page 1 would go on a local layer and when you go to page 2, it would not appear there. Every page in a document has at least one local object layer – Layer1 by default – and a local Guides layer.
By default, guidelines in CorelDRAW X4 are placed on the local Guides layer for the current page. In CorelDRAW X5 and X6 they are placed on the Master Page Guides layer by default. Choosing which guide layer is active before placing guides will ensure it goes where you want. If you draw ANY object on a Guideline layer, it will become a guideline. Guidelines do not have to be only straight lines!

Global layers appear on every page of the document. Global layers are also called Master layers. If you want a particular image or guide to appear in the same place on every page of the document, you can put it once on a Master layer or Master Guides layer.

The Grid is a Master layer and as such will be the same for every page of the document. You can set the Grid options by double clicking on the Ruler, then choosing Grid from the left column hierarchy in the Options menu. Change the color of the grid easily by dragging a color from the onscreen color palette to the color square icon beside the Grid layer in the Object Manager docker. You can turn the grid visibility on and off from both the Object Manager docker and from the View menu.
The Desktop is also a Master Layer. This is the layer that holds anything that is not at least partially on a page. Anything drawn on the work area, completely outside the page boundary, appears on the Desktop layer once another page has been viewed. (It remains on the active local layer until then to keep it in stack order for moving around on the page.) When an object is on the Desktop layer, it can be accessed no matter what page you are on. This is a great place to put a copy of an object that will appear on several pages but either not in the same place or not on all pages so you can quickly copy it to where you need it on each page.
By default, there is no Master Page Layer 1 like there are on other pages, but you can create a new Master Page layer by clicking the New Master Layer icon at the bottom left of the Object Manager.

You can make ANY layer a Master layer by right-clicking the layer name and clicking Master, but it is a good idea to always keep at least one local layer as well.

Beside each layer name in the Object manager are four control icons.

Clicking the Eye [image: image2.emf]

 icon will make that layer visible when the eye is open [image: image3.emf]

 and hidden when the eye is closed. [image: image4.emf]


Layers with the Printer icon [image: image5.emf]

not covered by the red nullify symbol will print. If the red symbol is over the printer icon [image: image6.emf]

, that layer will not show up when you print. By default, objects on the Guides, Desktop, and Grid layers will not print, but you can turn on printing for those layers if you wish. Be aware, however, that objects not on the page will most likely not print even if the Desktop layer is made printable. It is usually a good idea to clean up and remove any of these extra objects on the Desktop layer before printing or publishing to PDF.

The little color square icon is mostly a visual cue. This is the color that will represent that layer in Wireframe view. In the case of the Grid, you already know it changes the color of the Grid. Similarly, changing this color icon for a Guide layer will change any guide on that layer that is not currently selected to that color.

Change the color of these squares by right clicking on the layer and choosing Properties. In that dialog, you can set the Layer color as well as the other properties of the layer. You can also drag a color from the onscreen palette and drop it on the color square icon for the layer to make that color the layer color. Changing the layer color does not change the colors of objects on the layer. It only changes the color of the paths in Wireframe view. You can also use the layer color as a visual cue in the Object manager. You might want all your background layers to be one color, your artistic text layers another color, and your content text layers still another but the color would be consistent for each page of your document.

In this lesson, you will be creating some posters. You may wish to create a background layer, a layer for your photographs or artwork, and a layer for the text. You can rename layers to give them memorable names by right clicking on them in the Object Manager and choosing Rename. You can also click, then click again to get the text cursor to appear so that you can rename the layer. Layers will be more important when you start creating complex drawings, but understanding them and getting used to using them will be easier if you start while your documents are still relatively simple.
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Step 2 – Working with Bitmaps – Corel PHOTO-PAINT – Worksheet 4 A and B
Open the Corel PHOTOPAINT program. It should start with the Welcome Magazine as the splash screen. By now you should be familiar with how the CorelDRAW Welcome Magazine works. The Corel PHOTOPAINT Welcome Magazine is similar. If the Welcome screen does not appear when Corel PHOTOPAINT is first run, you can click the Welcome screen icon from the Standard Toolbar. [image: image8.emf]

 Flip through the various tabs to acquaint yourself with their contents. 
Work through the following tutorials from CorelDRAW X4 included in the lesson resources.

Workspace Tour


Retouching Images


Adjusting Images
View the Learning the Basics – Corel PHOTO-PAINT X5 or X6 videos. Links to these YouTube videos are included in the Resources folder.
Assignment 2 – Correcting Photos
In this assignment, you will work on correcting and improving three photographs.
Step 1

View the Color_correcting_photos.wmv video. A link to this 15 minute video is included in the lesson resources.
Step 2

In Corel PHOTOPAINT, open each of the photos in the Photos folder in the Lesson4 resources. Practice making simple corrections on each one as noted below:


Correct red eye – use redeye.jpg

Correct color – Use color.jpg

Correct contrast – Use brightness-contrast.jpg
You may also wish to correct other photos using these same techniques or a combination of them. You, your classmates, or your instructor may supply others to work on.

Compare your corrections to those of your classmates where you work on the same photo. Compare techniques. Every photo will be different and correction techniques are more of an art than a science. There is often more than one right answer to a correction problem depending on the desired outcome.

Sample Project 4 – A Motivational Poster

Most motivational posters and memes are fairly simple projects consisting of a short line or two of text and a photo that illustrates the concept declared by the text. When you create your own posters, you will want to consider what message you wish to convey, then choose a suitable photo to go with it. Memes usually start with an image giving it a clever caption. Here are the three posters you will create in this exercise.
[image: image9.emf]

[image: image10.emf]


[image: image11.emf]


The three photos are in the Photos folder of this lesson’s Resources folder. All three use the Arial Black typeface, but in different ways. The Arial Black font was chosen for these posters because it is widely available and already installed on most computers. You may choose to use a different font.
After you practice by creating these three posters, you will have the opportunity to create your own posters using the same steps below.

Step 1

Choose a message and one or more photos that work with that message. For these sample posters, the messages have been chosen for you as you can see above.

You may place the photo(s) one per page or put a couple of related photos on the same page. The photo(s) may be something beautiful and inspiring or something funny or otherwise eye catching. For this exercise, the following photos from the lesson Resources folder are used: Cat and Mice – PH00062.jpg, Lizard – PH0096.jpg, and Orangutan, PH00162.jpg. Each photo was used only once on its own poster.
Step 3

If the photo needs touchup or correcting this is the time to do it. The provided photos are just fine for our use in this exercise as they are.

Step 4

Import the photo into CorelDRAW. If you are using multiple photos, arrange them appropriately. Decide if the page layout should be portrait or landscape for best effect. For this exercise, all three posters are in portrait mode.
From the File menu, choose Import, then find the Cat and Mice photo. Click the Import button. You will be returned to the CorelDRAW window and your cursor should contain information about the image you are importing. Tap your Enter key to center the image on the page. In this case, the photo just fits nicely with good margins, so no further work is needed on this image. Save your work.
On a different page or in a different file, import the Lizard image using the same method. The photo is larger than the page, so it will need resizing. Scale it down to 7.5” wide. You can either type 7.5 into the Width field of the Property bar or 75 into the percent field. (The original photo imports in at 10” wide. 75% of 10 is 7.5.) In either case, make sure the little lock is active before you make the change so the height changes proportionately to the width. Save your work.
On a third page or a different file, import the Orangutan image as you have the other two. For this one, instead of the 7.5” width, use 7.7” instead. This makes a slightly smaller margin on the sides. Save your work.

Step 5

Size the photo(s) so they make the most sense in the poster. You should leave some margin of white space around your photo to allow for printing. Depending on the photo and your ideas for the photo, it may take only some, or all of the area of the poster. (You already did this for the exercise in step 4.) For internet memes, you may not need any margin. Save your work.
Step 6

Add any background color or other graphics needed.

The Cat photo has a lot of creamy colors, so a bright white paper background will be harsh against it. Place a cream colored background rectangle just inside the printable margins of white paper. Use the same color for the text.
For the lizard, to give a strong contrast to the photo, place a black filled rectangle behind the photo. Snap the black rectangle to the print area guides. The example shown at the beginning of this exercise has a black rectangle approximately 8” wide by 10.4’ high.
No extra graphics were used with the Orangutan photo.

Step 7
Add the text message. Things to consider are:

1. Typeface and size
2. Placement on the poster

3. Color

4. Do you want to see the photo through the text?
5. Do you want straight line text or text on a path?

6. Do you want decorative effects on the text (but not enough to make them unreadable)?

1. Typeface and size – For the exercise, and to make things simple, all three posters use the Arial Black typeface. For posters, you generally want to choose an easily readable font with enough weight to show up well. Fonts with “Black” in the name often will fit this category. Using a bold version of a typeface can also work.

The Cat poster uses a 24pt type size, the Lizard poster is 47, and the Orangutan poster is 113.5. In general, the more letters are in the message, the smaller the letters must be to fit on the poster. If you have small letters, they must have a good contrast value to the background, be a very clean font, and still not be less than about 24pts if you want them read from any distance. Even the Cat poster text at 24 points might be unreadable to many people beyond about 6-8 feet. Think about where your viewers will be when they see your poster and plan the text size accordingly. If you are making small images for the web, keep text at least 10pts.
2. Placement on the poster – This will depend a lot on the size of the text and the accompanying photo.

On the cat poster, the only clear place to put text is either near the bottom of the photo or in the margins. For this poster place the text baseline just over an inch from the bottom of the page and start the first C right between legs of the gray mouse.

There are several possible places for text on the Lizard poster. In this case, place it centered over the lizard’s nose about three inches down from the top of the page.
Again, there are several possible placements for text on the Orangutan poster. For this exercise, overlap both the photo and the background and center the text side to side. Notice that the cross of the H is aligned with the top of the photo.

3. Color – The important thing to think of with color is for it to contrast readily with the photo, but also not clash with either the photo or the background.

The color for the Cat poster should be the same color as the background.

The Lizard text is the same black as the background rectangle and ties into the black of the cord.

The Orangutan text has been chosen from the grass in the image using the eyedropper tool. It is then outlined in a brown from the Orangutan with a 3pt outline. Behind that, the text is further offset using the Interactive Drop-shadow tool with the following settings in the property bar:
Drop-shadow angle is 0 or grayed out.

Drop-shadow opacity is 70.

Drop-shadow feathering is 8.

Feathering direction is Average (this is a flyout control).

The transparency operation is Multiply.

The color is black. You might also effectively choose a darker shade of the green in the font.

Feathering Edges, Fade, and Stretch are grayed out with these settings.

For further information about the Interactive Drop Shadow tool, see the Creating drop shadows article in the Help documents or User Guide.

4. Do you want to see the photo through the text? All of these examples use completely opaque text. If you want to be able to see the photo through the text, you’ll probably want to outline the text for a deeper contrast, then use the Interactive transparency tool – probably in Uniform transparency mode most of the time. For more options when using the Interactive Transparency tool, see the Changing the transparency of objects article in the Help documentation or User Guide.
5. Do you want straight text or text on a path? This exercise only used straight text. Text on a path was introduced in a previous lesson. Text on a path is often used to emphasize the curve of some object in the poster or to allow a longer text string to flow around the edges of the poster.
Save your work! Save often. Don’t depend on the Automatic Back-up capabilities of CorelDRAW. As a matter of fact, it is best to do what is called iterative saves. Each time you add a significant element or make a significant change to your document, use the Save As… menu item to save the document with a new name. Choose a naming scheme like lizard1.cdr, lizard2.cdr. For complicated documents, you may want two levels of iteration, one for major changes and one for minor changes. This protects you in case one of your saved versions gets corrupted either by a bad save (power shuts down before the image is completely saved) or some other problem makes the image unusable. In that case, you only have to go back and redo the last changes you made instead of the whole project.

Assignment 4
Discussion and Research – Photography and Legal Issues

Use the various tutorials and Sample Project 4 along with the Essential Questions as a springboard for group discussion and/or research on photography related copyright issues, legal uses, and security and privacy issues when using photographs. Your instructor may choose to break larger classes into groups and assign certain questions to each group. The groups should then report the findings back to the whole class. The instructor may also choose to lecture on one or more of these subjects. Answer the following Essential Questions plus others you may encounter:

What are the copyright laws that pertain to using photographs? When is it legal to use them? When is it not legal to use them?

What are some safety/security/privacy issues in using photographs?

If you take a photo, is it always OK to use it for anything you want?

How could editing a photo be construed as being deceitful?

Assignment 5
Discussion and Research – Photography and the Photographic Industries
Research the one or more of the following topics individually or as a group as directed by your instructor:

The history of photography How has the technology changed over the years? What has remained the same? Discuss major changes in both cameras and the way photos are processed. What do you think the future of photography will look like? You may wish to include motion photography (movies and video) in your discussion.

The photographic industries What are the career opportunities in photography and photographic processing, editing or retouching? You may include both still photography and motion photography in your discussion. What do you think the future looks like for these industries?

Digital photography techniques What makes a good photograph? Besides equipment, what should you consider when taking a photo? For example, discuss subject matter, framing, lighting and other techniques of making a photo turn out well so that retouching may not be needed.
Be prepared to present your findings to the whole class.

Assignment 6
Create an original motivational poster
Use the information you have gained in Assignments 1-4 to create one or more original posters with the theme of your choosing.
Your poster should contain at least the following requirements:

1. Text elements – text describing your theme. Fonts should be readable from at least 8 feet away. Color and/or effects should be chosen to have enough contrast to aid reading but be harmonious with the total poster.
2. One to three photos per page – no more than three for this assignment. Photos should illustrate the theme you have chosen for the poster. If you use scanned photos or digital photos you have taken, they should be corrected if necessary using Corel PHOTO-PAINT.
3. You may use other graphical elements if you wish to enhance the photo(s) and text.
Your class should choose a venue to display your finished work. If you choose to use a website, size the images appropriately.
